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Introduction 

Waters Direct Sample Analysis technologies are a combination of high performance mass 
spectrometry and innovative direct sampling tools

1
. 

A key example is the REIMS (Rapid Evaporative Ionisation Mass Spectrometry) Research System, 
with its innovative iKnife hand-held sampling device

2,3
. This technology allows the rapid analysis of 

small molecules derived from a sample without any extensive sample preparation or chromatography 
being required (Figure 1). REIMS is the subject of this guide. 

 

 

 Figure 1: Schematic of REIMS iKnife-based Direct Sample Analysis. 

 

Immediate generation of sample data with minimal processing carries many advantages. On the other 
hand, the lack of sample preparation, fractionation or chromatographic separation could present 
analytical challenges to the user without dedicated software solutions. 

Such a solution has been developed for the analysis of small molecules by REIMS Direct Sample 
Analysis in Progenesis QI v2.1. This workflow allows a user to visualise, quantitate, discriminate and 
identify sample metabolites. All that is required is that the user applies Progenesis Bridge (included 
with MassLynx) to the analysis output files, and then selects the appropriate workflow option in the 
Progenesis QI software. 

Progenesis QI cannot process Direct Sample Analysis imaging data, such as MALDI (Matrix-Assisted 
Laser Desorption/Ionisation) and DESI (Desorption Electrospray Ionisation) imaging

4
. However, DESI 

ionisation in a non-imaging mode produces similar data to REIMS, and could be analysed using 
Progenesis QI. 
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Important Notes 

 

This user guide is a specific quick-start guide to using the Direct Sample Analysis workflow, 
covering all the basic analysis steps and options available to you. If you wish to know more about the 
use of Progenesis QI for LC-MS-based small molecule analysis, please consult the full user guide, 
which is freely available online: 

http://www.nonlinear.com/progenesis/qi/v2.1/user-guide/ 

If you wish to understand the general quantitation and identification approaches in Progenesis QI in 
more detail, please consult the detailed online FAQ guidance: 

http://www.nonlinear.com/progenesis/qi/v2.1/faq/ 

 

Demonstration Runs 

 

The data used to demonstrate the workflow in this quick-start guide are REIMS burns from different 
fish species (a speciation study). These are available as files ready-processed with Progenesis 
Bridge. However, you can easily follow this guide through with your own bridged data if you prefer. 

The data should be extracted from Progenesis QI DSA Data.zip. They are divided up into two 
folders. The first, Main Demonstration Data, contains the 25 raw files necessary to follow the main 
flow of the demonstration, along with a ready-made experiment design file that will help you set up the 
relevant experimental groupings for them. The second, New Sample, contains one further ‘unknown’ 
run which allows the demonstration of the speciation of a new sample later in the document. 

 

Licensing the Demonstration Runs 

 

If you are following the guide through with the demonstration data provided, and you do not already 
have a Progenesis QI license, please note that you will firstly need to license the files for use. This 
can be done by extracting the file RunLicense.ielf which is provided with the data in the same 
archive. Copy this file to the desktop of your analysis computer, and double-click it. The images will 
now be usable.  

 

  

http://www.waters.com/waters/en_US/Direct-Sample-Analysis/nav.htm?cid=134848674
http://www.waters.com/waters/en_US/Direct-Sample-Analysis/nav.htm?cid=134848674
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http://www.waters.com/waters/en_US/REIMS-Research-System-with-iKnife-for-direct-sampling/nav.htm?cid=134846529
http://www.waters.com/waters/library.htm?lid=134846772
http://www.waters.com/waters/en_US/Mass-Spectrometry-Imaging-Technologies-including-MALDI%2C-DESI-and-Ion-Mobility/nav.htm?cid=134833481
http://www.waters.com/waters/en_US/Mass-Spectrometry-Imaging-Technologies-including-MALDI%2C-DESI-and-Ion-Mobility/nav.htm?cid=134833481
http://www.nonlinear.com/progenesis/qi/v2.1/user-guide/
http://www.nonlinear.com/progenesis/qi/v2.1/faq/
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Create an Experiment 

 

The first step in Progenesis QI is to create the experiment – a project within which you can carry out 
the analysis of your data. You will need some basic information about your experiment. 

 

To create a new Direct Sample Analysis experiment: 

1. Load Progenesis QI v2.1. 
 

2. Below Other experiments at the welcome screen, click the New button (Figure 2). 
 

3. Name your experiment appropriately in the pop-up dialog box, and choose where you wish to 
save the results of your analysis as you progress (Figure 2). 
 

4. Click Next. 
 

5. In the following dialog, use the drop-down menu to select Direct sample analysis as your 
machine type. Specify whether you have profile or centroided data, and the correct ionisation 
polarity for your analysis (Figure 3). 
 
For the example, the data are profile mode, and of negative ionisation polarity. 
 

6. Click Next. 
 

7. In the next dialog box, select adducts appropriate to your ionisation method (Figure 4). At the 
identification stage of the workflow, these adducts will be considered as potentially being 
present. 
 
For the example, only [M-H] is defined. 
 

8. Click Create Experiment. This will take you to the Import Data page.  
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Create an Experiment – figures: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2: Creating a new experiment – generation and naming. 
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Figure 3: Creating a new experiment – selecting the Direct Sample Analysis method, data format and 
ionisation polarity. For the demonstration data, the data are in profile mode, and the polarity is 
negative. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4: Creating a new experiment – defining the adducts that may be present in the experiment. 
For the demonstration data, M-H is selected. 
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Import the Data 

 

The next step is to import your Direct Sample Analysis data. Some pre-processing should have 
already been carried out, as detailed below. For the demonstration data, this has already been done. 

 

Progenesis Bridge: 

Raw data files will initially be acquired and visualised using Waters’ MassLynx software, and may 
consist of several ‘burns’ in the case of REIMS data, where the user has performed several samplings 
in the same acquisition. 

These data are only resolved within a ‘burn’ in the m/z dimension, without any chromatographic 
separation. To correctly handle this type of data in Progenesis QI, a tool called Progenesis Bridge is 
used to convert the MassLynx raw data for analysis. This tool performs background subtraction, 
lockmass correction, the creation of extracted ion chromatograms for each burn and separation of 
multiple burns in each raw folder into individual raw folders. This also allows them to be correctly 
treated as individual samples. 

Once this process has been performed, the raw data are ready for importing into Progenesis QI, 
where they can be visualised, quantitated and statistically classified, and discriminating small 
molecules can be identified. 

Progenesis Bridge is supplied and supported separately, being included with MassLynx. 

 

Summary: 

 This guide assumes that you already have bridged data available in the Waters .RAW format. 

 

Importing bridged data into Progenesis QI: 

 

1. At the Import Data page, select the Waters (.raw) format (Figure 5). 
 

2. Click on Import. 
 

3. In the pop-up dialog, navigate to and select the folder that the raw files are contained within 
(Figure 5). 
 

4. Select all the files you wish to analyse. 
 

5. Click on Next. The software will examine the folders, and inform you of their readiness for 
import (Figure 6). Note that lock mass calibration is performed by Progenesis Bridge, and so 
there is no further lock mass calibration performed at this stage, which the software 
recognises. 
 
For the example data, there should be 25 files in total. 
 

6. Click on Import. 

 

You may set up and start the automatic processing in the next section while runs are importing, or 
wait till import is complete. 
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Import the Data – figures:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5: Selecting the correct file format, and the samples to be imported. Each sample is one ‘burn’ 
from an original multi-burn acquisition. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 6: Reviewing the sample information prior to import. 
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Carry Out Automatic Processing 

 

Once the data have been imported, the software allows you to automatically detect and quantitate the 
ions present, and carry out statistical analyses upon the results. The relevant steps can also be 
carried out individually, but using the automatic processing option is usually the quickest and most 
convenient way to analyse your data. 

 

For more information on each screen, please consult the main user guide and online FAQs, as 
described in the Important Notes. 

 

1. Once your runs have imported, or while the import is occurring, select Start automatic 
processing (Figure 7). 
 

2. A dialog box will appear marked Experiment design. 
 

3. If you wish, define an experimental design for discriminating between your sample groups that 
the ‘burns’ are derived from (Figure 8). If you do not create a grouping now, you can do so 
later. 
 
For the example data, the file Fish Groups.csv can be used to automatically carry out this 
grouping for you. 
 

4. Click Next. 
 

5. Peak picking will be displayed. This should be carried out, and so the box should remain 
checked. The parameters can be adjusted, but should not be, as they are already optimised 
for Direct Sample Analysis detection (Figures 9 and 10). 
 

6. Click Finish. 
 

7. Auto-processing will now occur, and the software will inform you of the results (Figure 11). If 
your experiment is still importing runs, then the auto-processing will proceed on completion of 
import. 
 

8. Click Close. 
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Carry Out Automatic Processing – figures: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7: Completed import, with the Start automatic processing button highlighted. 

 

 

 

 

 

 

 

 

 

 

 

Figure 8: Selecting an experiment design file (in this case, the csv file supplied with the 
demonstration set). 
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Figure 9: The Peak picking selection screen. The parameters are already optimised for this workflow 
but can be seen using Set parameters. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 10: The ready-optimised parameters for peak picking; Absolute ion intensity is used for the 
sensitivity setting, with a minimum intensity of zero. 
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Figure 11: The results of automatic processing are displayed after completion. Closing this dialog 
allows you to review the results step-by-step. 

 

 

Review Processing 

 

Once the processing has completed and you have closed the dialog, you can step through the 
Experiment Design Setup, Peak Picking and Review Deconvolution screens by using the Section 
Complete button or the workflow buttons at the top of the screen. 

All of these steps have been carried out to the extent necessary by the automatic processing (Figures 
12, 13 and 14). 

It is important to note that for Direct Sample Analysis data, there is no automatic deconvolution of 
adducts into compounds, as there is in the ‘generic’ workflow. However, you can still carry out manual 
deconvolution if you wish to assign different ions to the same compound. This process is explained in 
the main user guide, and it would require you to have selected all potentially relevant adduct types at 
the time of creating the experiment (only those types are made available at the Review 
Deconvolution step). 
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Review Processing – figures: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 12: The groupings are already set up at Experiment Design Setup, although more may be 
added at this stage (and will be later in the guide for OPLS-DA analysis). 
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Figure 13: At Peak Picking the detected m/z profile is visible. The profile will potentially appear quite 
crowded (back panel), but on zooming in (front panel) separate ions can be distinguished. 
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Figure 14: At Review Deconvolution potential adducts are shown for each compound. In this 
example data set, only [M-H] was defined on the creation of the experiment, so there are no other 
options. However, useful information is still available. 
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Initial Statistical Analysis 

 

Progenesis QI has in-built statistical analysis tools, including multivariate visualisations such as 

Principal Component Analysis (PCA) and hierarchical clustering dendrograms, along with ANOVA 

analysis to detect significantly altered compounds. While these are described in detail elsewhere, 

their use for the example data set is described below. 

 

PCA separation of different fish species 

1. Navigate to the Compound Statistics stage using the workflow button at the top of the 

interface, bypassing (for the moment) the Identify Compounds and Review Compounds 

stages. 

 

2. PCA results will be calculated, and displayed (Figure 15). 

 
3. Of particular note is the separation in the first two components of Pollock from all other 

species. We will return to this in the next section. 

 

Tagging of compounds that are significantly different between the groups for investigation 

4. In the table on the left of the page, compounds are listed along with their ANOVA result for a 

comparison across all the groups (Figure 16). 

 

5. To quickly select the compounds that are significantly different across the groups, and mark 

them for potential identification, right-click on this table and use Quick Tags > ANOVA p-

value… to apply a tag label at any level you desire (Figure 17). 

 
6. In this data set, most of the compounds are significantly altered between the samples, which 

are quite different in behaviour. Hence, we will instead focus on the discovery of compounds 

of interest by a second method, in the next section. 

 

Application suggestion: Speciation of an unknown sample by PCA 

With an experiment containing authenticated samples, unknown samples can be added and 
compared to your standards to suggest a tentative grouping / classification. 

If you do not wish to alter your current experiment with every such test, then first create an archive of 
the experiment from the main welcome screen, to save an unaltered copy you may return to at a later 
time. 

Once this has been done: 

 

1. Add the new run(s) at the Import Data stage. 
 

2. Move forwards through the experiment, using Section Complete or the workflow buttons at 
the top of the page each time (not the automatic processing). 
 

3. At Experiment Design Setup, create a new experimental condition group for the new run(s), 
and place them in it. 
 

4. Continue onwards, accepting the existing peak picking when you pass the Peak Picking 
stage. 
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5. When you reach the Compound Statistics screen, the new runs will appear as a new group 

on the PCA plot, and can be compared to the existing data grouping. 
 

Note that the presence of the new runs will affect the plot for all runs, and so this is not any kind of 
rigorous classification mechanism. Also, your ANOVA values will be affected (and even lost, if you 
only add one new sample, as there are not enough replicates for ANOVA in all the groups any more). 

This process is demonstrated using the demonstration data below (Figure 18). You may wish to try 

out the process yourself, using the file 20FEB2015_006_06.raw in the New Sample folder in 

Progenesis QI DSA Data.zip. This is a Cobbler sample. 

 

 

 

Initial Statistical Analysis – figures: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 15: At Compound Statistics the separation of normalised compound abundance profiles by 

PCA can be seen. 
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Figure 16: ANOVA values are presented in tabular form for each compound (note that for fold 

changes in the mean normalised compound abundance, see instead Review Compounds). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 17: Compounds whose mean normalised abundances differ significantly between the groups 

can easily be tagged for reference. 



Progenesis QI Direct Sample Analysis User Guide 

20 

 

 

 

 

. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 18: One may add new samples to an existing experiment, and using the existing detection, 

compare them consistently to the existing samples for (simplistic) classification purposes.  
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OPLS-DA Statistical Analysis Using EZinfo 

 

Note: This requires EZinfo 3.0.3 statistical software, available for purchase with Progenesis QI. 

Another way to find compounds of interest differing between groupings is the use of OPLS-DA 

(Orthogonal Projections to Latent Structures Discriminant Analysis). In this method, compound data 

are exported to EZinfo 3.0.3 statistical analysis software, which calculates the features that most 

effectively and robustly contribute to discrimination between two experimental groupings. These 

features can then be imported back into Progenesis QI as a tag set, and identified. 

Please note that this section continues from the previous one without the optional addition of the 

unknown sample to the demonstration data. If you have added the new sample, you may return to an 

archived version of the experiment from before it was added to match this guide exactly, or simply 

continue with it present. You will see similar results whichever option you choose. 

 

Generating an appropriate experiment design: 

The first step is to generate a pair-wise comparison; that is, two groupings. In the case of the example 

data, our initial examination suggested that Pollock vs other samples might be an interesting 

comparison, given the visibly ‘different’ behaviour of that species on the PCA plot. 

This requires formalising in an experiment design. To do this: 

1. Return to the Experiment Design Setup stage. 

 

2. Create a new Between-subject Design using the New tab. Select Copy an existing design 

(Figure 19) to create a copy of the existing fish groups. 

 
3. Delete all the groups apart from the Pollock group, and then re-add all the other samples into 

a new condition (Figure 20). 

 
4. Leaving this design selected (and so active), move back to the Compound Statistics stage. 

 

Exporting data to EZinfo 3.0.3: 

The next step is to export this comparison to EZinfo for external statistical analysis. Note that you 

should not have any tag filter applied at this stage (you want to export all the compounds for analysis). 

5. At the Compound Statistics stage, select File > Export to EZinfo… (Figure 21). 

 

6. At the pop-up prompt, save an EZinfo .usp file in an appropriate location. This is the record of 

the external statistical analysis; you may wish to also retain this file as well as the Progenesis 

experiment. 

 
7. EZinfo will launch after compound export (Figure 22). The groupings, data and appropriate 

data scaling are already set up correctly in the workspace, so all that is needed is to perform 

the appropriate analysis. 
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Discriminant analysis in EZinfo 3.0.3: 

We will apply an OPLS-DA analysis to the data to identify markers discriminating between Pollock 

and other fish species sampled in this study. 

8. Open the Model tab and select Change model. 

 

9. In the dialog, select Analyse group differences by “Condition” and select “OPLS-DA” 

(Figure 23). Whether you create the analysis as a new model or not is not important for the 

purpose of this demonstration (in this case, the box is unticked, so replacing the initial model). 

 
10. Now, select Plots and Spreadsheets, and the S-Plot (Figure 24). 

 
11. In principle, the compounds at the extremes of an S-Plot represent species that contribute 

highly to the discriminant separation model with high reliability. These are therefore your 

potential biomarkers. Select some by clicking and dragging (this is only a demonstration, and 

the exact species selected do not greatly matter). If selecting multiple regions, holding Ctrl is 

necessary to avoid only selecting the latest group. 

 
An example is provided (Figure 25). 

 
12. Select Transfer Loadings data on the side-bar (Figure 25). 

 
13. Close the EZinfo window, saving if desired. 

 

Importing the compounds of interest into Progenesis QI: 

 
14. Your selected species will be ready for import in the Collecting data from EZinfo window. 

Assign a tag to them as desired, creating it if necessary (Figure 26). Right-clicking the 

compound row, and then selecting the desired tag will then apply it to the compounds (Figure 

26). 

 

15. Click Import Tags. 

 

16. You will be prompted to close the connection to EZinfo on import – confirm this. 

 
17. Your tags will be applied, and you have marked the species contributing most notably to 

OPLS-DA discrimination between Pollock and other fish species. 

 
18. You can apply a tag filter to only show these potential biomarkers (Figure 27). These will form 

a good sub-selection for attempted compound identification in the next section. 
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OPLS-DA using EZinfo – figures: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 19: Create a new experiment design, copying the existing one that was generated by the 

template file for convenience.  
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Figure 20: Remove all the groups except Pollock using Delete on each group, and then re-add all the 

‘freed’ samples into a single comparison group. 
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Figure 21: Return to Compound Statistics, and export the data to EZinfo. Note the PCA appears 

identical (the same samples are being plotted) with the exception that all other samples form one 

‘super-group’; only the group colouring changes on the plot. 
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Figure 22: EZinfo will launch (after saving a usp file as prompted), with the data being ready for 

OPLS-DA analysis. Carrying out the analysis itself will be the next step. 
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Figure 23: From the Model tab, select Change model. In the Change Model box, select to analyse 

group differences by condition, and select OPLS-DA. 
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Figure 24: OPLS-DA analysis will be performed. The next step will be to select potential biomarkers 

contributing strongly to the discriminant model. Select Plots and Spreadsheets and S-Plot as 

shown.  
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Figure 25: Once S-Plot is selected from the Plots and Spreadsheets tab, the plot appears and you 

can select potential biomarkers from the extremes of the ‘S’. To select multiple groups, hold Ctrl while 

clicking and dragging. Once you have a satisfactory set, select Transfer Loadings data on the right-

hand side-bar.  
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Figure 26: On closing EZinfo, you are returned to Progenesis QI. Using the black arrow drop-down, 

create a tag for the import (if you have not created a suitable one already). Then right-click on the 

compound batch line, and apply that tag. The compounds can now be imported under that tag label. 
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Figure 27: Use the filtering function to show only the imported compounds. 
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Compound Identification 

 

Progenesis QI allows a number of search methods for biomarker identification. These include native 

support for ChemSpider, LipidBlast, Metlin and NIST. In addition, the Progenesis MetaScope search 

engine allows searching of any SDF or CSV database, e.g. those provided by HMDB, DrugBank and 

LipidMaps. 

For REIMS Direct Sample Analysis data, such as those in the example set, one would expect to 

predominantly see lipid species, so searching LipidBlast and the LipidMaps SDF file through 

Progenesis MetaScope are sensible starting points. 

However, both methods carry the caveat that for TOF-MS data, the lack of fragment information can 

make determining the correct identification amongst several putative ‘hits’ challenging. 

ChemSpider can also be used, but a great many putative identifications may be returned; the noted 

caveat is likely to be even more of an issue in this case. For more information on ChemSpider, see 

the online FAQs as detailed previously; only the LipidBlast and MetaScope methods are detailed in 

this guide. 

In all cases, to address the challenge of the lack of MS/MS data, DDA enhancement may help, and 

the process for achieving this is also described below. 

 

Identification using LipidBlast: 

Note that if this is the first time you have used LipidBlast, you will need to install the necessary 

databases. This is easy (and indeed automatic if you have internet access), as described in online 

FAQ material. 

1. Move to the Identify Compounds stage, with the tag filter still active from the EZinfo import 

in the previous section (that is, you are only seeing the compounds that you highlighted on 

import from EZinfo). 

 

2. Select LipidBlast from the drop-down menu (Figure 28). 

 
3. You can alter the tolerances if desired, but in this example the defaults will be used (5ppm for 

both precursor and fragment tolerances). 

 
4. Click Search for identifications. 

 
5. Putative identifications will be imported where available (Figure 29). 

 

 

Identification using the LipidMaps SDF in Progenesis MetaScope: 

For this method, you will require the structure SDF file available at LipidMaps. The file required is 

LMSDFDownload6Apr15FinalAll.sdf (or current version dependent on date), which is present in the 

downloadable structure archive (e.g. LMSDFDownloadApr15.zip). 

6. Select Progenesis MetaScope from the same drop-down menu as step 2. 

 

7. Under Choose search parameters, select Edit > Create New. 

http://nonlinear.com/progenesis/qi/v2.1/faq/compound-search-lipid-blast.aspx
http://nonlinear.com/progenesis/qi/v2.1/faq/compound-search-lipid-blast.aspx
http://lipidmaps.org/resources/downloads/index.html
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8. Create a search parameter set using the LipidMaps sdf file. Suitable parameters are shown in 

Figure 30; the set should be named, and the sdf selected in the Compound database field, 

but no other changes are necessary. 

 
9. Save the set using the Create search parameters button. 

 
10. From the main search menu, ensure this search method is selected, and click Search for 

identifications. 

 
11. As with the previous LipidBlast search, results will be imported where hits occur (Figure 31). 

 
12. Each method is assigned a letter, so that you can differentiate between results from the 

LipidBlast search (“A” in this case) and LipidMaps MetaScope search (“B” in this case) 

(Figure 32). 

 

For more information on other identification methods, please consult the main user guide and the 

online FAQ material, as detailed previously. 

 

Application suggestion: DDA enhancement 

For the REIMS data shown here, there is no fragmentation information; as noted, this makes specific 

identification more challenging. If you wish, you can improve your identification confidence and 

specificity by adding in information from separate DDA (Data-Dependent Acquisition) runs. 

Progenesis QI can then carry out a more detailed identification process utilising fragment information. 

To help with this, you can generate targeted inclusion lists for those runs. 

From the File menu, then select Export inclusion list… and a pop-up dialog will allow you to select 

the Masslynx format and export the list (Figure 33). This will then allow you to acquire targeted DDA 

data for all the species currently present in your tag filter. 

To use the information gained from DDA runs in your identification process, please consult the main 

user guide, as described previously. 
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Compound identification – figures: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 28: Selection of the LipidBlast search method at Identify Compounds, and the parameter 

selection dialog. 
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Figure 29: Example results obtained for compound identification from LipidBlast. 
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Figures 30 (above) and 31 (below): The MetaScope set-up dialog with the LipidMaps sdf file 

selected ready for searching, and an example LipidMaps MetaScope search result. 
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Figure 32: The LipidBlast and LipidMaps MetaScope search results are automatically differentiated in 

the results table, where a compound has hits from both. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 33: The Export inclusion list feature allows you to generate a targeted list for DDA analysis 

to improve your identifications. 

 


